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Hands-on 2: Working with vector data!

1) Follow the instruction “QGIS 3.10 Installation Instructions” if you have not already
installed QGIS on your computer.

Learning outcomes

By the end of this exercise, you will be able to:
1) Import vector data to QGIS
2) Perform different key processes (such as projecting, clip) with vector data

3) Georeference an image

1 This hands-on is an exercise developed by Khavari, B., 2019 Exercise 2: Working with vector
data [WWW Document]. OnSSET Teaching Kit. URL
https://onsset.github.io/teaching kit/courses/module 1/Excercise%202/ (accessed 2.18.21).

All images are screenshots from QGIS 3.10, which is licensed under Attribution-ShareAlike 3.0
Unported (CC BY-SA 3.0).
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Data Acquisition

Download the folder named “Benin_vector”, available here, and save it on the desktop.
Unzip and open this folder, in it there is a number additional folders and files. For this
exercise make sure that the following files/folders are included:

. An image named "“Benin_transmission_lines”.

. A folder named “Transmission_Lines”. Within this folder there should be files
named “transmission_lines".

. A folder named “Administrative_Boundaries”. Within this folder there should be
files named “Administrative_Boundaries”.

. A folder named “Administrative_Boundaries_Points” containing the administrative

boundaries of Benin in point format named “Administrative_Boundaries_Points”.

Note! It is good practice to use underscore (_) when naming folders or datasets in GIS (instead
of space) in order to avoid unexpected errors while processing.

Working with vector data

Open QGIS Desktop 3.10.X with GRASS 7.6.X.

NOTE: An extensive tutorial of QGIS is available here.

Import:
1. Importing vectors can be done in two different ways; either simply drag the vector file
onto your map canvas or go to the top roll-down menu and click on Layer > Add
Layer > Add Vector Layer...
1. Import the “"Administrative_Boundaries.shp” layer and the
“transmission_lines.shp” layer that you have received (when using vector layers we
search for the files with .shp extension).

Vector properties

Next, we will examine the properties of different vector files. By right-clicking on one of the
layers you will be able to examine and/or change properties of your vector files.

CCG 2021 Page 2


https://drive.google.com/file/d/1dtCO59PEfz4bWcFXk5VP7X6jAZhAQGZ9/view?usp=sharing
https://docs.qgis.org/3.10/en/docs/user_manual/index.html

Climate
Compatible

Growth

v [l adrim»
;;D Zoomer sur la couche

i) Zoom to Selection

2 Montrer dans I'apercu
Montrer le décompte des entités
Copier la Couche
Rename Layer

D Duplicate Layer

Q Remove Layer...

"= Quvrir la table d'attributs

/' Basculer en mode édition
Filter...
Set Layer Scale Visibility...

Set CRS 4
Exporter 4
Styles 4
. First, click on the Information tab. Here you will find information about your
layer.
@ Layer Properties - administrative_boundaries | Information ? X
ﬁ Information from provider ”
~
o Information Original administrative_boundaries
Name administrative_boundaries
Source Source  D:/EMP-A SouthAfrica 2019/ Vector_exercise/Administrative_Boundaries/

administrative_boundaries.shp
Storage  ESRI Shapefile
Comment
Encoding  System
Geometry  Polygon (MultiPolygon)
CRS  EP5G:4326 - WG5S 84 - Geographic
Extent  -3.2554150200000002,4.7387509300000001 : 1.1917699600000000,11.1732597859995997
Unit degrees
Feature count 1

Identification

Source Fields

Identifier
Attributes Form Parent Identifier
Title
Type
Joins Language
Abstract
ﬁ Auxiliary Storage C:tegor:::
r@ Actions
Extent
CRS
Spatial Extent
Rendering Temporal Extent
Variables
Access w

e - o] o | [ ][ e
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. The most important tab for the visual appearance of your dataset is the
Symbology tab. Here you can change many different aspects of the dataset. You can
change the color, style, and size of the vectors.

Q Layer Properties - administrative_boundaries | Symbology ? X
- E Single symbol hd
"i Information h . Fill
[ simple fil
':{s_'\ Source
# Symbology
AT
€7 Labels & L
Unit | Milimeter -
Diagrams =
Opaity I 100,0 % s
30 View Color =
Source Fields
E Attributes Form
Symbols in | Favorites ¥ | | Open Library
Joins L
ﬂ Auxiliary Storage -‘ -
{;1.@ REILE gradient p gray3fill  hashed black, hashed black = hashed black  outline blue  outline green
- Display * ;
O N vy -
Oa o a \ A 4 b

g‘ Rendering

Save symbol | | Advanced *

Variables

P Layer rendering

B vewicta o | Stle = [ ] cance Apply Help
J Next, we will move on to the tab named Source Fields. Here you will be able to
examine the fields in your data in more depth, which can help you identify the type of
data and their properties that exist in your dataset. This may be very useful when you
use a dataset that is created by someone else. If you have editing toggled, you will also
be able to add/delete columns in this tab as well.
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(=) Layer Properties - administrative_boundaries | Source Fields ? *
/)&
Information Id Mame Alias Type Typename Length Precision Comment WMS WFS
abc 0 GID_0 QString String M M

Source

I O A

Diagrams

3D View

E Attributes Form

Joins

ﬁ Auxiliary Storage
{J_@ Actions

- Display

S
& Rendering

Variables

.

Metadata Stle = Cancel Apply Help

Clipping vector layers

In many cases the dataset that you are using spans across an area larger than your study area.
In these areas it can be useful to delimit the dataset so that it is restricted to the area you are
working with. For all type of vector files, we will use the tool Clip. We will use this tool to make
sure that the transmission lines we will work with are constrained within the borders of Benin.
1. Make the toolbar visible by going to the menu on the top of the screen and click on
Processing - Toolbox.

(2} *Untitled Project - QGIS
Project Edit View Layer Settings Pluging Vector Raster Database Web | Processing Help

D- @@ @@Pé@ﬁ ;}gﬂ'gﬂ'ﬂﬁﬂmr Crl-+Alt+T

- — 7 %4 Graphical Modeler... Ctrl+Alt -+

‘l. } ) F 7 = o )
ﬂ % ] ‘,5 %] #J f'? o f rld / .’J’( m =€ B (9 History... Ctrl+Alt+H
DnSSET =  Results Viewer Ctrl+Alt+R

2. This will open up the toolbox on the right-hand side of the QGIS interface. In this
toolbox you can search for all the tools that you need.

CCG 2021 Page 5



Climate
Compatible

Growth

Processing Toolbox 5 x
b ORI

O, search...

Recently used

(3} cartography
(2} Database

(2 File tools

(2} Graphics

() Interpolation
) Layer tools

() Network analysis
() Raster analysis
(2} Raster terrain analysis
() Raster tools

() vector analysis
() Vector creation
() vector general
) vector geometry
&) vector overlay
() vector selection
() Vector table

T GDAL

% GRASS

¥ Models

& sAca

# Seripts

3. Now, search for “clip”, this will show all the tools including the word clip.

Processing Toolbox g X
LRGN
O dip

* Recently used
™ Clip raster by mask layer
~ (3 vector overlay
' dip
Extract/dip by extent
v = GDAL
“ Raster extraction
L0 Clip raster by extent
™ Clip raster by mask layer
» Vector geoprocessing
E&_- Clip vector by extent
ﬁ'& Clip wector by mask layer
v & SAGA

CCG 2021 Page 6



Climate
Compatible

Growth

4. In this exercise we will choose the clip tool within the QGIS-package (the one

highlighted in the image above).

5. In the window that opens up, choose the dataset that you wish to clip in the field that
says “Input layer”, and in the field that says “Clip layer” choose the dataset that you
wish to clip by. As the input layer choose transmission_lines, and as the clip layer
choose administrative_boundaries to clip the transmission line vector that you

received by the administrative boundary polygon.

) Clip
Parameters Log
Input layer
/" Layer to dip [EPSG:4325] -

Selected features only
Clip layer
|~ study area [EPSG:4328] v
Selected features only

Clipped

| [Create temporary layer] |

Open output file after running algorithm

Run as Batch Process. ..

Clip

This algarithm dips a vector layer using the
polygons of an additional palygons layer. Only the
parts of the features in the input layer that falls
within the polygons of the dipping layer will be
added to the resulting layer,

The attributes of the features are not modified,
although properties such as area or length of the
features will be modified by the dipping operation.
If such properties are stored as attributes, those
attributes will have to be manually updated.

0% Cancel

Run in Background Close Help

Export

Now it is time to export the clipped transmission lines to the appropriate folder. This is a very
important step. When you use a tool in QGIS, e.g., “Clip”, the output file will be saved as a
temporary file if you do not explicitly state that you want it saved on your computer. This
means that next time you open QGIS your layers will be lost even if you save the project. To

avoid this you can export your layers.

1. Right-click on the clipped layer and click on Export > Save Features As...

CCG 2021
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Layers B X

= l@ WTYEUT_;TQ

~
. »' Zoom to Layer
Zoom to Selection

Show in Owvenview
Show Feature Count
Copy Layer

Renarne Layer

Duplicate Layer

L
[l Remove Layer...
Move to Top

Open Attribute Table
/' Toggle Editing
Filter...

Set Layer Scale Visibility...

Set CRS »

Export - Save Features As...

Styles b Save Selected Features As..,
Properties... Save as Layer Definition File...

Save as QGIS Layer Style File...

2. Choose to export your vector files as ESRI shapefiles. Click on three dots next to
filename, and navigate to the folder you wish to save the layer in (see image below).
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(2 Save Vector Layer as... >
Format ESRI Shapefile e
File niame ||
Layer name
CRS EP5G:4325 - WG5S 34 | [

A
Encoding UTF-8 w

Save only selected features

w Select fields to export and their export options

MName Type
Narme string

Country  string
Voltage KV int3
From string

To string

Situation  string v

Select Al Deselect All

¥ Geometry
Geometry type Automatic v
Force multi-type

Indude z-dimension

I Add saved file to map I QK Cancel Help

3. Name your layer “transmission_lines_Benin” and navigate to the folder named
Transmission_Lines that you have received. Click "OK” (make sure that “Add saved
file to map” is checked). Now you can remove the temporary file named “Clipped”, by
right-clicking and selecting Remove Layer.

Projecting vectors

The coordinate system is very important when representing data. When projecting an area onto
a map there will always be a certain distortion. When choosing the coordinate system, it is
important to make compromises and choose the system that gives the least distortion. For this
exercise, since we are working with Benin we will have to choose a coordinate system that
works well for the country. In this case, we are choosing a coordinate system named "WGS
84/UTM zone 31N".

We will reproject the transmission lines that we clipped and exported.
1. In the toolbox search “Reproject layer” and double-click on it to use the tool.
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Processing Toolbox
®eo DA
L repro
w () Vector general
4%+ Assign projection
'#' Reproject layer

v = GDAL
* Raster projections

T Warp (reproject)

2. First, choose the dataset that you wish to project (the clipped transmission lines).

NOTE: When you choose the dataset you will be able to see the current coordinate
system within brackets (see image below).
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() Reproject Layer ? x
Parameters Log 4 = |
Reproject layer
Input layer
This algarithm reprojects a vector layer. It creates
|~ Dataset to reprojeclB[EPSG:4326] - | |.. @ a new layer with the same features as the input
one, but with geometries reprojected to a new
Selected features only CRS.
e Attributes are not modified by this algorithm.
EPSG:4326 - WGS 84 - | |
Reprojected
|[Create temporary layer]
Open output file after running algorithm
0% Cancel
Run as Batch Process... Run in Background Close Help

3. Next, click on the icon next to the field that asks for Target CRS and choose your target
coordinate system.
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(2 Reproject Layer ? had

Parameters Log Repl’(}j ect Iayer

Input layer
— This algarithm reprojects a vector layer, It creates
|~ Dataset to reproject [EP5G:4328] - | |.. @ a new layer with the same features as the input
one, but with geometries reprojected to a new
Selected features only CRS.
Target CRS

Attributes are not modified by this algorithm.
EPSG:4325 - WGS 84

Reprojected

‘ [Create temporary layer] ‘

Open output file after running algorithm

0% Cancel

Run as Batch Process... Fun in Background| Close Help

This will open the following window

{2 Ceordinate Reference System Selector ? >

Define this layer's coordinate reference system:

This layer appears to have no projection specification. By default, this layer will now have its projection set to that
of the project, but you may override this by selecting a different projection below.

Filter | O
Recently used coordinate reference systems
Coordinate Reference System Authaority ID
W35 84/ World Mercator EP5G:3395
WGS 84 EP5G:4326
< >
Coordi f y of the world [ Hide deprecated CRSs
Coordinate Reference System Authority ID ~
WGS 66 EPSG:4760
WGs 72 EP5G:4322
WGS T2BE EP5G:4324
WGS 84 EPSG:4326 v
< >
Selected CRS (WG5S 84
Extent: -180.00, -90.00, 180,00, 90.00
Proj4: +proj=longlat +datum=wWG584 +no_defs

Help
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In the filter field start typing the name of the coordinate system you want to use (UTM zone

31N).

{3} Coordinate Reference Systermn Selector

Define this layer's coordinate reference system:

This layer appears to have no projection specification. By default, this layer will now have its projection set to that
of the project, but you may override this by selecting a different projection below.

L4

a
Recently used coordinate reference systems
Coordinate Reference System Authority 1D
< >
Coordinate reference systems of the world [] Hide deprecated CRSs
Coordinate Reference System Authority 1D e
Mord Sahara 1959 / UTM zone 31M EP5G:30731
WGES T2/ UTM zone 31N EPSG:32231
WGES T2BE / UTM zone 31N EPSG:32431
WGES 84/ UTM zone 31N EPS5G:32631 v

Selected CRS |'|."I.I'GS 84/ UTM zone 31N

Extent: 0,00, 0,00, 6,00, 84,00
Proj4: 4+proj=utm +zone=31 +dat|.|m=WGSB4
+no_defs

NOTE: The unit is in metres (+units=m) and the red box on the map in the lower right corner

covers Benin.

4. Click on OK and Run in background to execute the tool. When finished, export as
“transmission_lines_Benin_reprojected” to the “Transmission_Lines” folder.

CCG 2021
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NOTE: For future studies the following site https://epsg.io/ can be used to determine which

coordinate system you should use. On this webpage you simply search for the name of your
study area and take the coordinate system best suited for your study.
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Georeferencing

In this par,t we will first georeference a map of Benin and use this in order to finish the missing
transmission lines. In many cases you will come across outdated or incomplete GIS data, and
this is a useful way of generating correct data when these cases occur.

Georeferencing
How to enable georeferencing:

Georeferencing can be a powerful tool when identifying certain datasets such as roads,
transmission lines, or locations of substations. If these datapoints are not available as geo-
spatial datasets, they can be imported as an image and then fitted to the study area.
1. First you may need to enable georeferencing. In many cases georeferencing is disabled
when you install QGIS. This is done by going to Plugins - manage and install
plugins... at the top of your screen.

(3} Untitled Project - QGIS
Project Edit View Layer Settings

NEBBRE
% @ v:. ﬁ. ﬁ "-_\ Python Console Cirl+Alt+P

Plugin Reloader L4

pcessing Help

sald 0

InSSET

2. In the window that opens up, start typing “georeferencer” and select “georeferencer
GDAL"” when it appears by checking the box next to it.

/" Plugins | All (553) ? *
ﬂ Al Search |geore|
i Another DXF Imparter [ DXF2Shape Converter All Plugins
i Installed . Freehand raster georeferencer
[] T Georeferencer GDAL On the left you see the list of all plugins available for
’. Mot installed - INSPIRE Mederland plugin voor QGIS your QGIS, both installed and available for download.
4 1Rectifier Some plugins come with your QGIS installation while
ﬁ Settings PR e e most _of them are made available via the plugin
repositories.

3. Now if you go back to the main screen and open the Raéter In'1enl,|"yc')'l,| shbulld have the
option to do georeferencing.
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(2} *Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector | Raster  Database Web Pro

D . ; ! @ q’ ﬁ) }'-" Raster Calculator..
Align Rasters..
% @ J“!! ¢} I#J iﬁ}. | 4 Analysis 3
Dn5SET Prujecﬁuns 4
Miscellaneous r
Layers B X
Extraction L4
(] Loov m
L@ - T : Conversian »
[/ Reprojected 1 Georeferencer .
'_J| - | o TPaep——p— R |

How to georeference
1. First open the Georeferencer. On the top of the screen click on File > Open Raster.

G". Georeferencer

File Edit Wiew Settings

&1 Reset Georeferencer kf }1
b
" OpenRaster... ctril+0
¥ Start Georeferendng Cirl+3
4 Generate GDAL Script Ctrl+C
- )
#@ Load GCP Points... Cirl -+
7% Save GCP Points as... Ctrl+s
Close Georeferencer Ctrl+0

2. Next, navigate to the image named “Benin_transmissionlines.jpg” in the Benin folder you
have downloaded. If you are prompted to choose a coordinate system choose WGS 84
(EPSG:4326).
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() Georeferencer - Benin_transmission_lines,jpg = O X

File Edit View Settings

P> Z%% @ s ossp ¢ ot

GCP table & X
Transform: Not set 2307,0 None

3. Now you will be able to add some control points to your map. These control points will
be used in order to line your image up with the rest of your datasets. Use your mouse
wheel or the icons at the top to zoom in and out of the picture. When you have zoomed
in to your liking you can click on the map to add a control point. This will open the

window below.

CCG 2021
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/ Enter map coordinates 7 x

Enter ¥ and ¥ coordinates (DMS {dd mm s5.55), DD (del da) or projected coordinates (mmmm.mm))
which correspond with the selected point on the image. Alternatively, dick the button with icon of a
pendil and then dick a corresponding point on map canvas of QGIS to fillin coordinates of that
point,

X /East || | ¥ /North | |

0K ﬁ From map canvas Cancel

Here you can choose to enter the control points using the map canvas directly, using the “From
map canvas” by just clicking on the corresponding point in your canvas. The more points the
better. The idea is to fit known areas of you image to known areas of the administrative
boundaries that you have imported.

NOTE: Instead of what is described above you can to add the coordinates of the point that you
clicked on directly in the X and Y fields. These coordinates should be entered in the coordinate
system chosen.

4. As you add points you will see that there are rows being added to the window named
“GCP table”. Each row represents a control point that you have added. The more points
the better, and you should make sure that your points are covering the entire study
area. For this exercise please add between 6 and 8 points (in general the number of
points should increase as the size of your study area increases).
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Q Georeferencer - Benin_transmission_lines,jpg

File Edit View Settings

W >

MG DR PP R B

GCP table

Visble 1D SourceX
1419,79

473,054
1851,38
849,856

WMo o

SourceY Dest. X  Dest. Y  dX(pixels) dY (pixels)
—253,304 —244,774 -2388,25
—1199,86 -148,386 -3159,36
-1182,88 —280,919 -2544,88
—3128,63 168,891 -3661,38

o o o o
o o o o

Residual (pixels)

o o o o

Transform: Not set

-1446,-3354  None

5. After entering all of the control points click on Settings - Transformation

settings...

CCG 2021
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(5} Transformation Settings x

Transformation Parameters

Transformation type |Thin Flate Spline e

Resampling method | Nearest neighbour e
Target SRS EPSG:i4320 - WGES 84

Qutput Settings

COutput raster Lin_‘-fEctnjrf'Eenin_transmissiu:un_lines_mu:udiﬁed.tif €&
Compression Mone e

|:| Save GCP points
Create world file only (linear transforms)
[ ] u=e 0 for transparency when needed
[] set target resolution

Horizontal

Vertical

Reports

Generate PDF map | |

Generate PDF report | |

Load in QGIS when done

Cancel Help

Set Transformation type to Thin Plate Spline.
Select the right coordinate system in Target SRS (WGS 84).

In the field for Output raster find the folder that you want to use for saving your raster
(choose the “Benin_vector” folder provided to you).

In set target resolution set the size of each cell. The smaller the cell size the better (set
0.0083 with minus sign as in the figure above). This is in degrees and corresponds to
approximately 1 km). NOTE: in order to change the resolution from the default you
have to check the box named “Set target resolution”; if you have to change the
coordinate system manually make sure to uncheck the box before the next step.
Having the box checked can cause errors.

Check the box “Load in QGIS when done”.

When this is done click on “"OK" to close the window.
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6. Finally go to File and click on Start Georeferencing.

/. Georeferencer - test2,jpg
File Edit View Settings

1 Reset Georeferencer

&, Open Raster... Cirl+0
[+ Start Georeferendng Ctrl+G
|4 (Generate GDAL Script Ctrl+C
i .
‘m Load GCP Paints... Ctrl+L
% Save GCP Points as... ctrl+5
Close Georeferencer Ctrl+Q

This might take some time. When it is done, the map should be in the same place as the
administrative boundaries.

(The map above has been created by putting the administrative boundaries on top of the
georeferenced image and turning its transparency to 50%. You can turn the transparency to
50% on the first window of the symbology tab in properties. This is a good practice if you want
to make sure that the dataset falls in the right spot and for the following steps).

7. Close the georeferencing window and click “Save”.
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NOTE: If your map ends up completely wrong this might be due to discrepancies in the
coordinate systems.

Edit vector files:

Sometimes it is of interest to either add points/lines/polygons to an existing dataset or create a
new vector dataset from scratch. Here we will go through the first option.
1. Move the reprojected transmission lines dataset to the top in the Layers Panel.
2. In the Symbology tab (in Properties) make the lines black and increase the Width to
make the lines clearly visible.
3. Right-click on the dataset and click on “Toggle Editing”.

Layers 8 x
o [l ® T &~ &L
— Transmission _lin D z ol
3 oom to Layer
B test2 : Y
. Reprojected

Zoom to Selection

Show in Overview

[+

Show Feature Count
Copy Layer

Rename Layer

Duplicate Layer

[l Remove Layer...

Open Attribute Table
. Toggle Editing
Filter...

4. This will enable some different options depending on what type of vector file you are
working with (if you are working with points, you will be able to add points; if you are
working with lines, you will be able to draw lines; if you are working with polygons, you
will get the chance to draw polygons).

g 1 po ,:, - -
L a L X
. K o6 @ s

Now you can simply click/draw your cursor wherever you want to add data by clicking
on the V-shaped line in the red box above (marked in the image above). After clicking
on this you will able to draw your lines by clicking on the map. The first click will define
your starting point, and thereafter you can add as many points as you like.

v
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s) ‘\\
} /
[ >
When you are finished with a line, right click on the last spot. This will open the following
screen:

Transmission_lines - Feature Attributes n

id | |

Here you attribute data. In this exercise we will just enter a number and for now it does not
matter which number you write, this is just a way to distinguish between different line-
segments.

Use the editor and the georeferenced map to fill in the missing transmission lines (only existing
lines, according to the legend at the bottom (green lines) of the georeferenced map) in the
reprojected transmission line layer that you have created

6. Click on Save Layer Edits and then disable Toggle Editing.

9 pa| -0 5 pa f o P
{ e & & =
B! R IR

Layers Panel & x

\‘@WY »

+ Trans...

NOTE: The accuracy of your lines and points depends on the scale in which they were created;
if you zoom in further after drawing your lines you will see discrepancies. One of these might be
that the lines do not connect to one another. To fix this go to Project - snapping options.
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iew Layer Settings Plugins Vector Raster

103 & Custom CRS...

- lC & Style Manager...
“%, Configure Shortcuts...

TR

g x % Customization...

» @% Options...
Snapping Options...

Here you set the variables as shown below.

(2} Project Snapping Settings 7 et

W= all Layers, Vertex, _ pX * | ¥ Topological Editing Snapping on Intersection

Now when you are close enough to a line QGIS will make sure that the new line is connected to
the old one.
7. Save the edits.
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Determining distance

In this part we will determine the distance to the transmission lines. When planning an energy
system it is crucial to know the distances to different infrastructure in order to be able to take
informed decisions.

Creating distance maps

When calculating distances in QGIS we need to use two point layers. This means that we
cannot simply determine the distance from the modified transmission lines without first
converting it to points.

Convert the transmission lines to points:
1. To convert the transmission lines to points we are going to use a tool named "convert
lines to points" from the SAGA package.

Processing Toolbox &
'*‘g V=

1, convert lines to points |

% Recently used
B Clip raster by mask layer
6 Raster values to points
% Clip
4 Reproject layer
& Convert lines to points
v g GRASS
¥ Vector (v.¥)
@ w.tolines
v & sacA
* Vector line tools

@ Convert paints to line(s)
% Vector point tools

& Convertlines to points

2. Clicking on the tool will open the following window.
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(2} Convert Lines to Points ? *

Parameters Log
Lines
"/ Lines to convert to points [EPSG:32631] | || |
Selected features only

Inzert Additional Points

Insert Distance

Ak

| 100,000000 a
Points

[5ave to tempaorary file] |

Open output file after running algorithm

0% Cancel

Fun as Batch Process... Close Help

For lines you choose the transmission lines that you edited at the end of the Part 2.

The Insert distance will determine the distance between the points. This distance will be in
the same unit that the coordinate system is in. Since we have projected the transmission lines
to a coordinate system that takes metres, this distance is in metres. Enter 100 to create points
spaced with 100 metres in-between.

Create a distance map:
1. Import the administrative_boundaries_points layer of Benin and reproject it using
Reproject layer into "WGS 84 /UTM zone 31N"” as done previously in this exercise.
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This is done since it is important to have the map in a coordinate system that takes
linear units, else the distances may be skewed. Furthermore, if the coordinate systems
are different between two maps used to determine distances the distances will be
wrong.

2. To create a distance map we use the QGIS tool Distance to nearest hub (points).
Search for it in the Processing Toolbox.

Processing Toolbox

'*‘1 AL B Sy

O, distance to nea

v (3 Vector analysis
4% Distance to nearest hub {line to hub)
'*' Distance to nearest hub {points)

vy GRASS
¥ Vector (v.¥)
@ v.distance

3. You will then see the following screen:
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(=) Distance to Mearest Hub (Points) ? e
Parameters Log
Source points layer
Points [EPSG:32631] | L] @
Selected features only
Destination hubs layer
" reprojected_transmission_lines_benin [EPSG:32631] > | L] @
Selected features only
Hub layer name attribute
abe MName 4
Measurement unit
Meters v

Hub distance

| [Create temporary layer]

Open output file after running algorithm

0% Cancel

Run as Batch Process... Run in Background Close Help

As Source point layer, put the layer that you want to determine the distance to, in this case
the country point file: administrative_boundaries_points.

As Destination hub layer, put the layer that you want to determine the distance from. In this
case this is the point layer we generated previously from the transmission lines:
transmission_lines_Benin_reprojected.

NOTE: The layers should have the same coordinate system.

For Measurement unit, you have the choice between some different types of length units. In
this case, choose Meters.

4. Now run the tool. The results will be a point layer with the same colour across the
country. This can however be changed in the Style tab in Symbology. Change the
style to make the map display as below. You can do this by clicking on the symbology
tab in properties, setting the style to graduated, and choosing to display the distance
column.
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NOTE: Export the distance map, as it will be used in the raster exercise as well. Save the
distance map under the name “transmission_lines_distance” in the “Benin_vector” folder.
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